Level 2 BCS Section 2 Create Solution

Section 2
Create Solution

By the end of this Section you should be able to:
Use IT systems and software to complete planned tasks
and produce effective outcomes

Use shortcut techniques to improve overall efficiency
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Section 2 Create Solution BCS Level 2

Exercise 9 - Create a Solution

Guidelines

When all planning is complete, the actual solution can be created using the
selected application. Whilst developing the solutions, always remain aware of
the relevant points of the scenario specification and of the constraints and
factors that may arise from them. Make sure the solution takes them all into
account.

It is not the purpose of this unit to test knowledge of the individual applications.
The technical level required should be no more than that covered by the
appropriate specific units at this level, e.g. word processing, spreadsheets. To
guote from the Assessment Specification for this unit, “Any aspect [required by
the solution] that is unfamiliar will require support and advice from other
people”.

There are, however, some techniques specifically mentioned in the
Assessment Specification for this unit that users may not have covered. The
principles of these techniques will be described in the next exercises in this
section.

Examples

1. Producing a newsletter using Word could involve the following skills:
o Formatting (fonts and backgrounds)

o Column layout

o Inserting text from other files (copy and paste will be adequate)
o Inserting and manipulating images

o Using visual effects such as Clip Art or WordArt.

2. The picture on the next page shows an example page of a suitable
newsletter.
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Section 2 Create Solution

Exercise 9 - Continued

ining

Barnacle 7Tra

Newslather

Friday 27" March 2009

New Gontract

Yesterday saw the signing of a historic contract between
Futland Council and Barnacle Training to provide all training
resources across the whole of the County.

Barnacle's chairman, Bill Barnacle said today that this
represented a landmark achieverment in the histony of

the company. "It will guarantee our future for years to

come”, he said. "Special praise is due to the sales

team, headed by Lindsay Lafitte",

A program of recruitment for all job types is expectec
to start almost immediately to cope with the extra wark

nenerated by the contract.

Bounty

In wiew of the farthcoming
recruitment  campaign,  any
employee  who  successtully
introduces a new starer to the
company will earn a hounty
payment of £200. This will be
payable after the first 6 months
of employment.

Wedding of the Year

June of this year wil see the
wedding of Sue  Mightingale
(Personnel) to Rocky Brown
(Froduction). This is seen as a
significant event, uniting as it
does  these two  histonc
deparments. The reception will
he held in the canteen and
senior  management  will  be
making an appearance.

Chef

This week we welcome back our
famous chef Jim Tripe from his
lengthy spell in hospital. Although
the canteen has heen ably
managed in his absence, it will
he good to get him hack in
charge and see the food return to
its unigque hlend of guality and
adventure.

Oldest Employee

Bob Ludd, 84, is retiring next
week after 40 fine wears of
continuous  service.  Personnel
Manager Brian Walders said "He
should have gone vears ago but
we all forgot he was there".
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Section 2 Create Solution BCS Level 2

Exercise 9 - Continued

3. Producing an induction presentation using PowerPoint could involve the
following skills:

o Slide formatting (fonts and backgrounds)

o Inserting text from other files (copy and paste will be adequate)
o Inserting and manipulating images

o Using visual effects such as Clip Art or WordArt

o Using simple animation effects

4. The picture below shows four sample slides from a suitable presentation
as an example

Turnover
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Level 2 BCS Section 2 Create Solution

Exercise 9 - Continued

5. Producing an hourly pay spreadsheet using Excel could involve the
following skills:

o Worksheet formatting (fonts and backgrounds)

o Inserting data from other files (copy and paste will be adequate)
o Wide range of formula

o Fixed referencing

o Totalling

6. The picture below shows a sample spreadsheet that could have been
created as a solution.

Hourly Paid Employees
week commencing 30/03/2009 Basic Hours
40
Mo Surname  First Department Rate Total Hours  Bonuses Gross Pay
1 Parke Meil Finishirng £12.00 30 £360.00
2 Patel Ravinder Finishing £14.50 25 E362.50
3 Chesterton lan Froduction £10.00 a0 a0 £550.00
4 Srith David Testing £14.00 40 £560.00
4 WWaldram  Zara Testing £12.00 40 £450.00
6 Smith James  Production £10.00 40 50 £400.00
7 Waterman David Testing £13.00 30 £390.00
8 Smith John Production £10.00 40 50 £400.00
9 Westgarth Shaun  Maintenance £12.50 45 £893.75
10 Mehillan  Rose Froduction £10.00 40 a0 E400.00
11 Wright hargaret Production £10.00 40 a0 £400.00
12 Zapora Androv  Maintenance £12.50 45 £593.75
17 Singh “ikram  Finishing £11.00 40 £440.00
18 Ornan Tarig Maintenance £12.50 45 £893.75
19 Leigh Clare Maintenance £12.50 30 E375.00
20 Chapman  lan Testing £10.00 40 £400.00
21 Ripley Ellen Testing £13.50 ] £472.50
22 Odara Desmond Production £10.00 40 a0 £400.00
23 Sovich Mikhael  Production £10.00 42 50 £430.00
£8,501.25
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Section 2 Create Solution BCS Level 2

Exercise 10 - Templates

Guidelines

A template is a blank framework of a document (or a spreadsheet or a
presentation) which can be saved and used as the basic for future documents,
etc. This can increase efficiency as the same layout does not have to be
entered every time a new document is produced.

As an example, this exercise will demonstrate the creation of a template
document in Microsoft Word XP or 2003. Any difference in 2007 will be noted.
The same principles apply to other applications.

It is assumed that the user is competent in the use of the relevant application,
Word in this example. If not, read the exercise for information only, or consult a
guide specific to the application.

Actions

1. Start Word and create a new blank document.

2. Type the title Barnacle Training. Change the font to Tahoma (or any
other font), size 28pt, and align the text centrally.

3. Apply pale blue shading to the title text.
4. Apply a Page Border of 1pt Shadow.

5. When all required formatting is applied, the document can be saved as a
template. Select the Save As option.

6. Enter a File name of Barnacle and in Save as type, select Document
Template.

Note: In Word 2007 the file extension is .dotx. Depending on the settings on your
computer the file extension may not be shown at all.

File mame: |Barnacle.du:ut

Save as Lype: |D|:u:ument Template (*.dot)

7. Make sure the location for the save (Save In) is set to Templates. This
may be set automatically or you may have to select it.

8. Click Save. The template is saved for future use.

9. Close the current document.
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Level 2 BCS Section 2 Create Solution

Exercise 11 - Macros

Guidelines

A macro records keystrokes and menu selections, then plays them back
exactly as they were recorded. A macro can be created so that a commonly
used task can be performed, or a word, phrase or paragraph can be entered
automatically. The use of macros results in the more efficient production of
documents. Once macros have been created, they can be used at any time in
any document that uses the same template.

As an example, this exercise will demonstrate the creation of a macro in
Microsoft Word XP. The same principles apply to other applications.

It is assumed that the user is competent in the use of the relevant application,
Word in this example. If not, read the exercise for information only, or consult a
guide specific to the application.

Actions

1. Create a new document in Word. Instead of creating a blank document,
select General Templates from the New Document area (My templates
in 2007).

2. Select the Barnacle template created in the previous exercise and click
OK. A new document is created with all the content and formatting of the
template.

3. Create three blank lines under the title and insert any picture or clip art
from your computer. Make sure the image is selected.

4. Select Tools | Macro | Record New Macro (Record Macro button on the
Developer tab in 2007). Enter Border as the Macro name.

Macro name:
|Border

Assign macro to

g i'\ Toolbars @ kevboard
[==]

Skore macroin:
|F'.II Documents (Mormal, dok) ﬂ

Descripkion:
Macro recorded 4)2/2009 by bob

K | Cancel

=
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Section 2 Create Solution BCS Level 2

Exercise 11 - Continued

5. Click OK to start recording the macro.

6. Select Format | Borders and Shading.

Note: In 2007, select Borders and Shading from the Border button in the
Paragraph group on the Home tab.

7. Define a 3pt, Double Line border in dark green and click OK to apply it to
the image.

8. Stop recording the macro.

9. Add two more blank lines then insert another image.

10. Select the image and select Tools | Macro | Macros.
Note: In 2007 click the Macros button on the Developer tab.

11. Select the Border macro and click Run. The macro runs, applying the
green border to the new picture.

12. Save the document in My Documents (Documents in 2007) as
Barnacle2 and leave it open for the next exercise.
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BCS Section 2 Create Solution

Exercise 12 - Shortcuts

Guidelines

There are various shortcuts that can be applied to IT solutions to make them
more efficient. For example your toolbars can be customised to include
shortcuts to any macros that have been created and shortcuts to files or
applications can be included on your Desktop.

Actions

2007 users go to step 9.

1.
2.

6.
7.
8.

Users of XP /2003 select Tools | Customize.

Click on the Commands tab and scroll down the list of Categories until
Macros appeatrs.

Click on Macros to view all the macros created.

Click and drag Normal.NewMacros.Border up on to any toolbar. When
the mouse is released a new button appears.

m 100% - |NnrmaI.NewMachs.Bn:-rderI @ -

Click on Modify Selection in the Customize dialog box and in the Name:
box, enter Picture Border.

Click on Change Button Image.
Select the smiley face from the choice of button icons.

Click Close to close the dialog box.

XP /2003 users go to step 14.

9.

10.
11.
12.

13.
14.

Users of 2007 right click on the Quick Access Toolbar and select
Customize Quick Access Toolbar.

Click on the Popular Commands drop down arrow and select Macros.
Select the Border macro and click the Add>> button.

Click on Modify. Select the smiley face icon and in the Display name:
box, enter Picture Border. Click OK.

Click OK to close the dialog box.

Insert another image into the document.

€=
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Section 2 Create Solution BCS Level 2

15.

16.

Exercise 12 - Continued

With the image selected, click the new button on the toolbar to run the
macro. The green border will be applied.

To remove the new button from the toolbar, hold down the <Alt> key and
drag the button down off the toolbar.

Note: In 2007 right click the new button and select Remove from Quick Access
Toolbar.

17.

Select Tools | Macro | Macros.

Note: In 2007 click the Macros button on the Developer tab.

18.
19.
20.
21.

22.

23.

24.

25.
26.

To delete the macro, select the Border macro, then click Delete.
Select Yes at the prompt and click Close.
Close the document without saving and close Word.

Shortcuts can be made to files, folders or programs. Select My
Documents (Documents in 2007) from the Start menu.

Right click on the Barnacle2 file and select Send To, then Desktop
(create shortcut).

Close the My Documents window (Documents in 2007) and display your
Desktop. There will be a shortcut icon on the Desktop for the file.

2B

Shorkcut ko
Barnaclez,doc

Double click on the icon. The Barnacle2document will be opened in
Word.

Close the Barnacle2document and close Word.

To remove the icon from your Desktop, right click on it and select Delete.
Click Yes at the prompt.
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Level 2 BCS Section 3 Review and Adapt

Exercise 13 - Revision

1. In which two of the following examples would the use of a template be the
most appropriate?

a) A monthly report showing the number of books borrowed from each
section of a library

b) A presentation showing your holiday photographs
c) A rejection letter to unsuccessful job applicants

d) A letter to a friend

2.  Which of the following processes could best be replaced by a macro?
a) Format each real name in a document as Bold

b) Resize each image in a document as 10cm by 6cm with a dark
blue border

c) Crop each image in a document to highlight the relevant parts

3.  Why is it appropriate to place a macro on a toolbar?
a) Because it looks good
b) Because it will not work otherwise

c) Because it is more convenient to run
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